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Learning Objectives 

• Understand the Coastal Hazard Analysis Modeling Program (CHAMP) and 
its use in assessing coastal flood hazards 

• Understand how to import digital elevation data 

• Understand how to perform analyses of storm-induced erosion, wave height 
analyses, and wave runup analyses using CHAMP 

• Plot summary graphics of the results and create summary tables and reports 
in a single environment. 
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Introduction 
The Coastal Hazard Analysis Modeling Program (CHAMP) is a software program 
designed to enable the user to perform storm-induced erosion treatments, wave 
height analyses, and wave runup analyses associated with coastal flood hazard 
assessments for the Federal Emergency Management Agency (FEMA) Flood 
Insurance Studies (FIS) and revisions to Flood Insurance Rate Maps (FIRM).  This 
tutorial will demonstrate the many functions of the program including entering, 
visualizing, tabulating and graphing data, and performing coastal engineering 
analyses within a user-friendly graphical interface. 
Prior to running CHAMP for the first time, users should: 

• Have an understanding of FEMA’s coastal flood hazard mapping program 
and the procedures for updating and revising a FIS and FIRM; 

• Have an understanding of and experience in coastal engineering analyses, 
including storm-induced erosion, storm surge flooding, wave height 
generation and attenuation, wave runup, and wave overtopping; 

• Be familiar with functions and assumptions of Wave Height Analysis for 
Flood Insurance Studies (WHAFIS) 3.0 and RUNUP 2.0 programs; and 

• Be familiar with the operation of a CAD program. 
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Program Overview 

Development 
 
What is CHAMP? 
CHAMP is a Windows-interfaced Visual Basic program that allows the user to 
enter data, perform coastal engineering analyses, visualize and tabulate results, and 
chart summary information for each transect within a user-friendly graphical 
interface. 
CHAMP was developed to simplify and reduce the time to perform a complete 
analysis of coastal flood hazards. 
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Program Overview 

Audience 
Intended Audience Usage 
CHAMP is currently used by: 

• FEMA offices 

• Flood Map Production Coordination Contractors 

• State and local National Flood Insurance Program coordinators 

• Coastal engineering firms 

• Revision requestors 

Guidelines and Specifications for Wave Elevation Determination and V-Zone 
Mapping (Final Draft-March 1995) and US Army Corps of Engineers Shore 
Protection Manual (1984) can be used as references for further detailed 
information and graphics. 
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Program Overview 

Limitations 
There are some limitations in the usage of CHAMP. 

• Designed for Windows 95, 98, 2000, NT, and ME. 

• Should only be applied to Atlantic Ocean, Caribbean Sea, and Gulf of 
Mexico coastal regions. 

• Existing WHAFIS and RUNUP input files cannot be imported directly into 
CHAMP. Associated data need to be re-entered into Transect Data Entry 
(Program 2) and respective model applications. 

• Linear orientation; editing, addition or deletion of data is not automatically 
incorporated into the tabular or graphical results from preceding programs. 

• Automated mapping features have not been developed. Graphics can be 
saved for use in other CAD or Geographic Information System applications. 
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Program Overview 

Components 
CHAMP analyses are completed in 3 general steps: 

• Project Information and Data Entry 

• Modeling 

• Summary Graphics and Tables 

These 3 steps are composed of 6 programs. 

• Project Information and Data Entry 
o General Transect Description/Parameter Entry (Program 1) – project 

information and general characteristics of transects 
o Transect Data Entry and Editing (Program 2) – transect ground profile 

station and elevation data 

• Modeling 
o Erosion Treatment (Program 3) – analysis of transect data for expected 

storm-induced erosion quantities and geometries, if needed 
o Wave Height Analysis (Program 4) – analysis of wave heights to 

establish wave crest elevation 
o Wave Runup Analysis (Program 5) – analysis of wave runup elevation 

• Summary Graphics and Tables 
o Graphics and Tables (Program 6) – view the results from the analyses 

for a selected transect 
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Program Overview 

Summary 
After completing this overview of CHAMP, you should understand: 

• the development and purpose of CHAMP; 

• the intended usage and additional technical resources available to assist you; 

• the program’s limitations; and 

• the overall, 3-step approach to hazard identification employed in CHAMP. 
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Running CHAMP 
Here are some tips to help in the execution of files and programs when running 
CHAMP. 
File Organization 
To organize general project information and transect data, CHAMP generates one 
MS Access database file, to which the user does not have direct access.  Transect 
data files for WHAFIS and RUNUP are stored in a subfolder with the same name 
as the database file. 
Data and output file names begin with “W” for WHAFIS, and “R” for RUNUP, 
followed by the name assigned by the transect in CHAMP, followed by the file 
type; data (.dat) or output (.out). 
Graphic files of the transect are named after the transect and are .dxf files. 

 

Please Note: To avoid overwriting an existing project file, create a unique folder name (which 
should not be changed) for each project or store the files on diskette. 
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Running CHAMP 
Main Menu Button Bar 
The Main Menu Button Bar allows access to the programs in a logical sequence. 
CHAMP runs unidirectionally 
Changes or additions to transect data in WHAFIS will not be saved in the General, 
Transect, and Erosion programs previously completed. 
For example, if the user wants to modify station/elevation data or the stillwater 
elevation (SWEL) after all modeling is completed, they must: 

• Update the appropriate Project Information and Data Entry information 
(Programs 1 and 2) for the selected transect, 

• Go to the Erosion program (Program 3), 

• Make the necessary adjustments in the Erosion program, 

• Be sure to Save changes in the Erosion program, and 

• Rerun the WHAFIS (Program 4) and RUNUP (Program 5) programs in 
order to  

• Incorporate changes into the Summary Graphics and Tables (Program 6) 
programs. 

Graph results in each program 
The summary graphics produced at the end of CHAMP rely on .dxf files produced 
in the Erosion, WHAFIS, and RUNUP programs along the way.  The results must 
be graphed at each program step in order to create the .dxf file that is used in 
Summary Graphics. 

 10



Running CHAMP 

Summary 
Upon completion of the “Running CHAMP” section of the tutorial, you should 
understand: 

• the basic file organization and file-naming conventions for CHAMP output, 
and 

• the unidirectional flow of data through CHAMP program modules 

You’re now ready to begin coastal flood hazard analysis, starting with Project 
Information and Data Entry.  
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Project Information and Data Entry 

Create a new project 

• Click the New button on the Main Menu Button Bar (or choose New Project 
from File drop-down menu) 

• Enter a unique file name to store all of the CHAMP project files.  This will 
create a database file (.mdb) and data folder with the same name.  Click 
Save. 
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Project Information and Data Entry 

Create a new project (continued) 
Once the database and file folders have been created, the Project Information 
window will appear to enter necessary background information for the project. 

• Project Title (project name): a name that will sufficiently help to identify 
the project site. 

• Modeler name: your name. 

• Community Name: name of the community to which the analysis is being 
applied.  Should be the same name as the community name on the FIRM. 

• Client name: name of the client/organization whom you are conducting this 
assessment. 

• Vertical Datum:  Select one. 
o NAVD 88 or NGVD 29. 
o All data should reference the same vertical datum used on the FIRM 

• Projection:  Select one. 
o Lat/Long (Latitude/Longitude) 
o State Plane 
o UTM (Universal Transverse Mercator) 

• Transect Unit System: Select one. 
o English (feet) 
o Metric (meters) 

• Estimated FIRM scale: anticipated scale of the FIRM to be created.  
Current scale selections are 1 inch = (x) feet (400, 500, 800, 1000, or 2000) 

(Note: The most common map scale for coastal FIRMs is 1 inch=500 feet.) 

• Number of Transects:  Establish the number of transect files that will be 
analyzed. 

(Note: The number of transects can be increased at any time.  This step will be discussed in the 
next section, “Open an existing project.”) 
Click the Build button. 
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Project Information and Data Entry 

Create a new project 
Import multiple transect data 

• Click File from the program Main Menu. 

• Select Import Data.  The Import Wizard-Step 1 window appears. 

• Click on the Browser button in the top right of the window to create a file 
name and location for the project. 

• The Create New Project window appears.  Select the location or folder 
where you want to save the project. 

• Type the file name in the File Name field of the Create New Project 
window.  Click the Save button. 

• Click the Next button in the Import Wizard window. The Import Wizard-
Step 2 window appears. 

• Click the Browser button.  The Data Import window appears. 

• Select the file where the transect data are located.  Files types which contain 
transect number and station/elevation pairs can be imported, such as: 
o Comma delimited text file (.csv) 
o MS Excel (.xls) 
o DBASE (.dbf) 
o MS Access (.mdb) 

• Click the Open button. 
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Project Information and Data Entry 

Create a new project 
Selecting data types and data fields 

1. If the database or spreadsheet contains multiple tables or worksheets, select 
the data table or worksheet with the transect data you want to import from 
the Select Data Table Field box in the Import Wizard Step 2 window. 

(Note: All imported data must be from one data table or worksheet.  Only one data table or 
worksheet can be imported.) 

2. The selected data table will display the data fields for the selected data table 
in the Select Data Field box. 

3. If you are not sure which data are contained in the data fields, a display of 
the first few rows of data are shown below in the spreadsheet preview 
window. Each station/elevation data point in the data table must have an 
associated transect number. 

4. Select a data type (Transect, Station, Elevation or Source), and then select 
the data field from the Select Data Fields box that has the data that is 
previewed in the spreadsheet preview window.  The data field name will 
automatically be populated in the field next to the data type. 

Repeat steps 1-4 to assign a data type to each data field from the imported file.  
Only one data field per data type can be selected.  The Source data type is not 
required to import data, but is optional. 

Data should NOT have: 
• Blank rows separating transects or data points 

• Text title rows 
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Project Information and Data Entry 

Create a new project 
Selecting data types and data fields (continued) 
The transect data that were imported can be filtered by the change in slope along 
the profile. 

• Enter in the minimal absolute angle (in degrees) allowed between any three 
consecutive data points. 

• If the angle made by the three data points is less than the given angle, the 
middle point will be removed from the imported transect. 

• A zero (0) in this field means that no data will be filtered and all data points 
from the data table will be imported. 

Once all of the data have been selected, click the OK button to import the transect 
data and create the project. 
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Project Information and Data Entry 

Open an existing project 
Existing projects can be opened to update or include additional information. Also, 
existing projects created in previous versions of CHAMP can also be opened. 
CHAMP will convert the file to the newer version. Be sure to back up the older 
CHAMP version project files before opening in the new version to prevent any 
accidental data loss.  

• Click the Open button on the Main Menu Button Bar (or choose Open 
Project from the File drop-down menu). 

• Go to the folder containing the database file (.mdb) for the project. 

• Select and open the .mdb file. 

• The Project Information window appears. 

(Please Note: If transect data types and fields were already assigned in the existing project, 
please continue to the next slide.  If not, please complete this procedure by following the steps 
described in the section, “Importing multiple transect data.” 

 17



Project Information and Data Entry 

Input and Edit Transects 
To Add Transects 

• Click on Transect from the main drop down menu.  

• Select Add Transect. 

• The Add Transect(s) window appears with Existing Transect(s)  and fields to 
Add New Transect ID. 

• Enter a Transect ID for each additional transect. The Transect ID can be 
letters or numbers, up to 15 characters. 

• Click the OK button. 
To Delete Transects 

• Click on Transect from the main drop down menu. 

• Select Delete Transect. 

• The Remove Transect(s) window appears with Available Transect(s) and 
Remove Transect(s) fields. 

• Select the transect from the Available Transect menu and: 
o Click on the single right arrow to move the selected transect, or  
o Click on the double right arrow to move all of the transects to the 

Remove Transect(s) field.  
o Click on single left arrow to move the selected transect from the Remove 

Transect(s) field to the Available Transect(s) field, or  
o Click on the double left arrow to move all of the transects from the 

Remove Transect(s) field to the Available Transect(s)  
o Click the Delete button to remove the selected transect(s). 

(Please Note: Transects cannot be added or deleted in the Number of Transects field in the main 
Project Information window.) 
To Edit Transect IDs 

• Click on Transect from the main drop down menu. 

• Select Edit Transect ID.  

• The Transect ID Editor window appears. Rename the transect. Again, the 
Transect ID can be letters or numbers, up to 15 characters. 

• Click the OK button. 
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Project Information and Data Entry 

Transect Description 
To run the Erosion Assessment , WHAFIS, and RUNUP programs, the user must 
first create or select a transect to be analyzed, then provide some additional 
information about that transect. 

• Click on the pull down menu labeled Transect ID: in the top right corner to 
select a transect. 

• Click on the General button on the main menu button bar to open the 
Transect General Information window.  The transect type, location, and 
general characteristics are stored here.  None of the information entered in 
the Description fields of the Transect General Information window will be 
used for any of the engineering computations. Under the Description tab, 
enter: 
o Transect Type – description of shoreline type that most closely matches 

(e.g., Sandy Beach - Small Dune). 
o Description of Transect Location – transect location relative to fixed 

landmarks (e.g., South of Town of Washington, at Lincoln Avenue). 
o Range and Direction Left: - Looking landward, the Range is the along-

shore distance to the left of the transect line (e.g., 3500 feet). Direction is 
the bearing of the Range, in degrees, referenced clockwise from 
North(e.g., 90 degrees). 

o Range and Direction Right – same as Range and Direction Left, except 
to the right of the transect line. 

o Location of Station 0 – Description of the location of the “zero” station 
to be entered in the transect profile. The unit options for these fields 
include decimal degrees (dd), meters (m), and feet (ft) based on the 
Projection (latitude/longitude) field input in the Project Information 
window. The Bearing refers to the orientation of the transect looking 
landward from Station 0. 

o Transect Characteristics – Physical and cultural description of the area 
the transect (e.g., vegetation, structures or development, fine sand, 
cobble, etc.). 
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Project Information and Data Entry 

Transect Parameter Entry 
Under the Parameters tab of the Transect General Information window, transect 
details regarding storm surge, wave parameters, and source data are stored.  Units 
for the majority of the data fields are established in the main Project Information 
window.  

• The following fields are required and must be completed (the Other 
Flooding Source section is optional). 
o Flooding Source – name of the body of water for which flood hazards 

are being analyzed (e.g., Atlantic Ocean). 
o 1% SWEL (1% Annual Chance Stillwater Elevation) – 1% annual 

chance (100-year) stillwater elevation without wave setup, referenced to 
the stated vertical datum, also referred as “storm surge.” Enter amount to 
the nearest tenth (using a decimal format with one decimal digit) in this 
field (e.g. 10.4). 

o Source (of 1% SWEL) – description of methods or references used to 
determine 1% annual chance stillwater elevation. 

o 10% SWEL – (10% Annual Chance Stillwater Elevation) – 10% annual 
chance (10-year) stillwater elevation without wave setup, referenced to 
the stated vertical datum. Must be entered, even if value is zero. 

o Source (of 10% SWEL) – description of methods or references used to 
determine 10% annual chance stillwater elevation (e.g., FEMA Surge 
Model). 

o Mean High Water Elev. (Mean High Water Elevation) – Referenced to 
the stated vertical datum. Must be entered, even if value is zero. 

o Mean Low Water Elev. (Mean Low Water Elevation) – Referenced to 
the stated vertical datum. Must be entered, even if value is zero. 

o Source (of Mean High Water Elev. and Mean Low Water Elev.) – 
description of methods or references used for determining the mean high 
water elevation and mean low water elevation (e.g., NOAA). 
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Project Information and Data Entry 

Transect Parameter Entry (continued) 
o Type of Event – Select Hurricane, Northeaster, or Tsunami from drop 

down menu. 
o Fetch Length – Measured in miles, the maximum open water reach over 

which storm-induced winds are expected to occur.  Maximum effective 
value is 24 miles. If deepwater wave conditions are specified, a zero may 
be entered. 

o Source of wave or fetch data – description of methods or references 
used for determining wave or fetch conditions. 

o Significant Wave Height – wave height associated with the 1% annual 
chance storm event. This field is needed for WHAFIS and RUNUP 
analyses. 

(Note: If the area has a restricted fetch and Fetch Length will be used to calculate wave height, a 
zero may be entered.) 

o Deepwater Wave Period – peak spectral wave period in seconds 
associated with the 1% annual chance deepwater wave height. 

(Note: If the area has a restricted fetch and Fetch Length will be used to calculate wave height, a 
zero may be entered.) 

o Wave Setup Magnitude – value of apparent wave setup effect to be 
added to 1% annual chance stillwater elevation. Must be entered, even if 
value is zero. Used in wave height analyses, but not in runup analyses. It 
is an additive to the stillwater elevation and the base flood elevation. 

o Method for determining wave setup magnitude - description of 
methods or references used for determining wave setup magnitude. 

o Other Flooding Source fields – can be used to enter other information 
about the flooding source not related to the main flooding source as a 
transect transverses landward 

• If the information for a new transect contains the same information for an 
existing transect, click the Copy button in the lower left corner of the new 
transect window to fill in all the fields with information from a previously 
entered transect. 

• Click the OK button in the lower right corner of the Transect Information 
window to return to the main Project Information window. 
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Program Information and Data Entry 

Transect Data Entry and Editing 
Entering Transect Data 
All transect information must be completed before Erosion Assessment , WHAFIS, 
RUNUP, and summary programs can be executed. The Transect Edit Program 
window will store information regarding the transect ground profile station and 
elevation data in feet. 

• Select a transect from the Transect ID drop down menu in the main Project 
Information window. 

• Click the Transect button. The Transect Edit window for the selected 
transect appears. 

• Starting at the row marked by an asterisk [*], enter all of the Station and 
Elevation data points for the transect.  Enter the Source of the data point as: 
o Surveyed 
o Topographic Map 
o Bathymetric Map 
o Global Positioning System (GPS) 
o Digital Terrain Metadata (DTM), or 
o Light Detection and Ranging (LIDAR) 
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Program Information and Data Entry 

Transect Data Entry and Editing 
Importing Station and Elevation Data 
If the station and elevation data already exists in a separate comma-delimited text 
input file (.csv), you can import this data into the Transect Edit window for the 
selected transect. 

• Select a transect from the Transect ID drop down menu field of the main 
Project Information window 

• Click the Transect button on the Main Menu button bar.  The Transect Edit 
window for the select transect appears. 

• Click on File from the main menu bar and select Import. Go to the folder 
where the existing transect station and elevation data is stored and select the 
file (.csv). Click the Open button. 

• The station, elevation and source data will appear in the Transect Edit 
window for the selected transect. 
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Program Information and Data Entry 

Transect Data Entry and Editing 
The Transect Edit window displays the following buttons. 

• Transect – displays the station, elevation, and source data as entered or 
imported. 

• Adjusted – displays the station, adjusted station, elevation, and source table 
created in the database, which will be used by other programs. 
o If this table is not created, Erosion Treatment, WHAFIS and RUNUP 

cannot run. 
o If a shoreline (0,0) point is not available in the original transect data, the 

profile will be adjusted accordingly by adding a zero elevation and 
corresponding station.  This point is required for WHAFIS. 

o The text “interpolated” will appear in the Source column if a shoreline 
(0,0) point was now included in the original transect data. 

• Graph – displays either the original transect or adjusted transect data in a 
graph, depending on which table is being viewed when this button is clicked. 
The Insert and Remove button are visible only in graph mode. 
o Insert – used to insert data points in the graphical view of the transect 
o Remove – used to remove data points in the graphical view of the 

transect. 
• To update the database table with changes made in the graph, click on 

Graph from the main menu in the Transect Edit window, and select 
Update table. 

• To undo changes made to the graph, click on the Transect button or 
exit the Transect Edit window. 

o A Primary Frontal Dune (PFD) point can be added when viewing the 
adjusted transect graph. 
• Click On Graph from the main menu in the Transect Edit window, 

and select Landward Toe (PFD) 

• Select the point along the transect where the landward limit of the 
primary frontal dune is located. 

• Refresh  - reformats Field Station and Elevation columns in numerical order 
of station value, if new data entered. Also, reformats the view of changes 
made in graphs. 
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Program Information and Data Entry 

Summary 
Upon completion of the “Project Information and Data Entry” section of the 
tutorial, you should have all transect data and relevant project information saved in 
CHAMP-compatible file formats, ready for use in subsequent modeling steps. This 
should be true regardless of whether the user opened transect data and project 
information from an existing CHAMP file, or created new transects and entered 
project information manually on-screen. 

You’re now ready to create Erosion, WHAFIS, and RUNUP models for the 
transects. 
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Modeling 

Erosion 
Erosion Assessment 
Wave analysis transects normally undergo FEMA’s standard Erosion Assessment  
before being used as input to the WHAFIS or RUNUP models.  This assessment 
procedure is based on the requirements concerning storm-induced of the primary 
frontal dunes as established in Section 65.11 of the National Flood Insurance 
Program regulations.  CHAMP assists in performing the erosion assessment  and 
adjustment through the Erosion Assessment Program (Program 3).  The Erosion 
Program will display the adjusted transect data on a graph of elevation vs. distance 
(station), with increasing stations being landward. 
The erosion modeling may be skipped if the transect data already reflect post-
storm, eroded conditions.  You can proceed with the erosion assessment on 
selected transects or skip to the WHAFIS or RUNUP programs.   
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Modeling 

Erosion 
Erosion Assessment  
The erosion assessment analysis is performed graphically by selecting points along 
the transect profile in the graph. The program requires the user to select points to 
perform the erosion assessment. Data point selection can: 

• Following the criterion set forth in Section 65.11 of the National Flood 
Insurance Program regulations, establish dune reservoir (or select the peak 
of the dune) to: 
o Remove the dune, if reservoir is less than 540 sq ft, or 
o Retreat the dune, if reservoir is more than 540 sq ft 

• Create eroded profile for removed or retreated dune 

If the transect profile has erosion treatment information in place before starting the 
assessment, click Clear Model under the File menu of the Erosion Assessment 
Program window.  The model can be cleared if an erosion analysis was performed 
previously and you would like to re-do the erosion analysis.  
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Modeling 

Erosion 
Establishing Dune Reservoir 

• Select the transect from the Transect ID drop down menu in the main Project 
Information window that you would like to perform an erosion assessment. 

• Click the Erosion button in the main Project Information window.  The 
Erosion Assessment Program window appears for the selected transect. 

• The following parameter controls are included at the top of the Erosion 
Program window. 
o Peak 
o Toe 
o Face (Face Slope) 
o Approach (Approach Slope) 
o Seaward (Seaward Slope) 
o Remove (Remove Slope) 
o Reservoir (Computed Reservoir Area) 
o Deposit (Deposit Area) 
o Status (Erosion Profile Status) 
o Eroded (Eroded Area) 
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Modeling 

Erosion 
Establishing Dune Reservoir (continued) 
The elevation and distance (station) points of the transect are graphed according to 
the adjusted elevation and station points from the Transect Data table. The 
elevation is represented on the Y-axis (horizontal) graph gridlines and distance is 
represented on the X-axis (vertical) graph gridlines. 

• Select the Peak field button in the top of the Erosion Assessment Program 
window. 

• Click on the appropriate peak of the dune in the transect profile. The 
appropriate peak would be the highest point of the primary frontal dune 
(PFD). (See Guidelines and Specifications for Wave Elevation 
Determination and V-Zone Mapping for more information on how to identify 
the PFD.) 

• If the peak needs to be moved or re-selected, simply click the Peak field 
button and re-select the appropriate point. 

The coordinates of the point selected will be shown in the data fields next to Peak. 
Also, the program automatically calculates and draws in the dune reservoir (yellow 
dashed area). The reservoir value is shown at top of the Erosion Assessment 
Program window in the Reservoir field.  This field cannot be changed. 

(Please Note: According to Section 65.11 of the National Flood Insurance Program regulations, 
the minimum value of the dune reservoir before the dune is considered retreated by FEMA 
standard is 540 square feet.  The program will also show whether the dune is removed 
(REMOVE) or retreated (RETREAT) in the Status field of the Erosion Assessment Program 
window. 
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Modeling 

Erosion 
The reservoir is calculated as the cross sectional area between the: 

• 1% annual chance SWEL 

• a vertical line drawn through the dune peak, and 

• transect ground profile for the foreshore dune area (seaward of the dune 
crest) 

According to Section 65.11 of the National Flood Insurance Program regulations, 
if the reservoir area is calculated to be less than 540 square feet, the profile 
adjustment will be for dune removal, and stated as REMOVE in the Status field of 
the Erosion Assessment Program window. 
If the reservoir area is calculated to be more than 540 square feet, the profile 
adjustment will be for dune retreat, and stated as RETREAT in the Status field of 
the Erosion Assessment Program window. 
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Modeling 

Erosion 
Erosion Assessment Program 
If the Status field of the Erosion Assessment Program window states REMOVE: 

• Select the Toe field button in the top of the Erosion Assessment Program 
window. 

• Click on the appropriate place that best represents the location of the dune 
toe in the transect profile. The appropriate toe would be the approximate 
location of the intersection of the 10% SWEL with the seaward side of the 
ground profile. 

• If the dune toe needs to be moved or re-selected, simply click the Toe field 
button and re-select the appropriate point. 

• Click the Remove field button in the top of the Erosion Assessment Program 
window. The program will draw the eroded profile and calculate the eroded 
area as shown in the Eroded field of the Erosion Assessment Program 
window. 

• If the 1% SWEL is above the entire ground profile, then a removed dune 
profile will be created. 

If the Status field of the Erosion Assessment Program window states RETREAT: 

• Select the Face field button in the top of the Erosion Assessment Program 
window. 

• Click on the approximate place that best represents where the eroded area of 
the dune reservoir may be equal to about 540 square feet. Try calculating as 
close as possible if you cannot estimate 540 square feet exactly. 

• The Eroded field at the top of the Erosion Assessment Program window will 
give you the calculated eroded area. 

• If the eroded area of the dune face needs to be moved or re-selected to equal 
approximately 540 square feet, simply click the Face field button and re-
select the appropriate point. 

Please Note: To make point selections more precise, you can click the right button on the mouse 
anywhere in the graph to Zoom Window, Zoom In, Zoom Out, Full Extent, or Pan. 
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Modeling 

Erosion 
Erosion Assessment Program (continued) 

• Click the Seaward field button in the top of the Erosion Assessment Program 
window. 

• Click on the approximate place for the 1-on-12 slope where the eroded 
material will be placed.  The program will calculate the depositional area 
and show where the seaward slope will be placed. 

• Check the Deposit field at the top of the Erosion Assessment Program 
window to see if it matches or is close to the volume calculated in the 
Eroded field.   
o If the seaward slope area needs to be moved or re-selected, simply click 

the Seaward field button and re-select the appropriate point on the dune 
profile. 

o If they match or are close, the erosion treatment is complete! 

• Once the erosion treatment is complete, the eroded profile for the transect 
needs to be saved in the database by selecting Save Model from the File 
menu of the Erosion Assessment Program window.  CHAMP will 
automatically create a data table of the eroded profile that will be used in 
WHAFIS (Program 4) and RUNUP (Program 5). 

Please Note: Again, to make point selections more precise, you can click the right button on the 
mouse anywhere in the graph to Zoom Window, Zoom In, Zoom Out, Full Extent, or Pan. 
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Modeling 

WHAFIS 
Wave Height Analysis for Flood Insurance Studies (WHAFIS) is used to determine 
wave heights associated with the 1% annual chance stillwater elevation (SWEL). 

(Note: The program is run on selected transects. RUNUP (Program 5) may be run before or 
after WHAFIS in CHAMP.  For the purpose of this tutorial, WHAFIS is presented first.) 

• Select the transect you would like to run in WHAFIS from the Transect ID 
drop down menu in the main Project Information window. 

• Click the WHAFIS button in the main Project Information window.  The 
WHAFIS window appears for the selected transect. 

• Click Populate Data from the File menu of the WHAFIS window to transfer 
the data from the eroded transect completed in the Erosion Program 
(Program 3) or non-eroded transect data entered in the Transect Data Entry 
and Editing Program (Program 2). 

• The station and elevation columns will be filled in with transect data for the 
selected transect. 

• WHAFIS uses points landward of the first zero (0,0) elevation only. 
WHAFIS will populate only data points that are equal or below the total 
stillwater level. Areas above the 1% annual chance stillwater (with setup) 
are above surge; therefore, wave crests are not computed. 

• WHAFIS is limited to 200 data points per transect. In some cases, some data 
points may need to be removed before running the program. 

• Only the stations used for WHAFIS will need input cards. 
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Modeling 

WHAFIS 
The WHAFIS Card column is defaulted to inland fetch (IF) for all points, except 
the first point, which must always be initial elevation (IE). 
Click on the drop down menu in the WHAFIS Card column to select the 
appropriate card for the data point. 

• IE – initial elevation 

• IF – inland fetch 

• OF – overwater fetch  

• BU – buildings 

• DU – dune 

• VE – vegetation 

• VH – vegetation header 

• AS – above surge 

The Building, Dune, Vegetation, and Vegetation Header cards require additional input.  An 
input window will pop-up for these cards. 
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Modeling 

WHAFIS 
Total 1% annual chance SWEL – The first station for this field will be filled in 
with the 1% annual chance SWEL, plus the setup entered in the Transect 
Description/Parameter Entry Program.  If there are changes in either component of 
the Total 1% annual chance SWEL as the transect proceeds inland, for each 
applicable station, enter the altered value in the appropriate column. 
Possible changes for Total 1% annual chance SWEL: 

• If ground elevations on the barrier island do not rise above the Total 1% 
annual chance SWEL (i.e., the island is completely inundated), the wave 
setup component of the value may be removed for Inland Fetch segments of 
the transect.  

• If ground elevations on either the barrier island or mainland coast rise above 
the Total 1% annual chance SWEL, WHAFIS will terminate the transect.  If 
that transect continues farther inland and crosses a secondary flooding 
source, the 1% annual chance SWEL for that source (plus or minus setup, as 
appropriate) should be used. 

• If the ground elevation rises above the 1% annual chance SWEL and then 
drops below the 1% annual chance SWEL along the transect path, two 
station and elevation data points will need to be entered manually on the 
WHAFIS profile at those locations.  
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Modeling 

WHAFIS 
Make Graphical Changes to WHAFIS with new data points 
The WHAFIS graph for the selected transect will show all of the original adjusted 
or eroded profile ground elevation transect points and lines. Data points should be 
located at all intersections of the SWEL and ground profile. 

Again, to make point selections more precise, you can click the right button on the mouse 
anywhere in the graph to Zoom Window, Zoom In, Zoom Out, Full Extent, or Pan. 

To add a transect point: 

• Click on the Insert button of the WHAFIS Graph window. 

• Click on the point along the profile where additional points are needed. 

• Click on the Refresh button to update the graph to see the results of the new 
inserted points. 

• The station and elevation of the new points will not be inserted into the 
WHAFIS data input table until the table is updated. 
o Select the Graph menu at the top of the WHAFIS Information window. 
o Select Update Table from the menu. 
o If points need to be removed from the graph, click on the points to be 

removed and then click the Remove button. 
o If the points entered or removed are not correct, click on the Data button 

then the Graph button before updating the table from the Graph menu. 

• Click on the Data button of the WHAFIS Graph window. 

• Select the appropriate WHAFIS Card field for the additional data points 
updated into the table. 
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Modeling 

WHAFIS 
Running WHAFIS 

• Select the Program menu from the WHAFIS window and select Run 
WHAFIS to execute the program. 

• A CHAMP window will appear. 
o If the window displays, WHAFIS run finished, the program is complete 

and ran successfully. Click the OK button. 
o If the window displays an error message, WHAFIS did not run 

successfully and input data should be checked for errors. 

• While in the graph view of the selected transect, select the Graph menu from 
the WHAFIS window and Graph Results to view the profile showing the 
input profile, stillwater elevations and wave envelope.  

Please Note: The WHAFIS program must be run and the results graphed in order to create a .dxf 
file that is used in Program 6, Summary Graphics. 
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Modeling 

WHAFIS 
WHAFIS Data Viewing 
The Results menu from the WHAFIS window includes the input and output results. 

• Input text file 

• Output text file 

• WHAFIS output files 
o Part 1 – input information 
o Part 2 – controlling wave heights, spectral peak wave period, and wave 

crest elevations for the data points 
o Part 3 – location of areas above 100-year surge. If no areas are above the 

100-year surge, no table will be displayed. 
o Part 4 – location of surge changes, if any. 
o Part 5 – locations of Zone VE to Zone AE gutter; windward (WIND) 

and Zone AE to Zone VE gutter; leeward (LEE) 
o Part 6 – station and location of base flood elevation and respective A-

Zone and V-Zone designations for mapping purposes. 

Exit the WHAFIS program by clicking the [X] button in the upper right corner or 
select the File menu and select exit. 
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Modeling 

RUNUP 
The RUNUP program applies to runup on sloped beaches for the selected transect 
only. If the transect data in the project  do not reflect sloped beaches, then proceed 
to Program 6, Summary Graphics. The US Army Corps of Engineers Shore 
Protection Manual can be referenced for runup on vertical walls.  Additional runup 
calculations can be made with the USACE Automated Coastal Engineering System 
(ACES). 
FEMA’s Guidelines and Specifications for Wave Elevation Determination and V-
Zone Mapping should be consulted for more complex situations, including those 
where overtopping of low barriers occurs.  
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Modeling 

RUNUP 

• Select a transect from the Transect ID. Click on the RUNUP button from the 
Main Menu Button Bar.  The RUNUP window for the selected transect will 
appear. 

• The window will display transect: 
o Station 
o Elevation 
o Description of Surface – defaulted to SMOOTH; other selections 

include: 
• TIGHT PAVING BLOCKS 

• TURF 

• LOOSE PAVING BLOCKS STEPS 

• COARSE GRAVEL/GABIONS 

• ROUNDED STONES 

• ARMORED UNITS 

• OTHER 
o Roughness Coefficient – default to 1 for smooth runup surfaces; adjusts 

automatically according to Description of Surface column 
o Station Status – indicates which stations will and will not be used for 

input into the RUNUP model (Include or Exclude) 
• Limited to 20 data points 

• Maximum offshore station for RUNUP input is –9999. 

• Default to Exclude; select appropriate button for each data point 

• All data points landward of the highest point on the runup slope 
should be excluded. 

o Notes, if any. 
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Modeling 

RUNUP 
Running RUNUP 

• Click Populate Data from the File menu of the RUNUP window to transfer 
the data from the eroded transect completed in the Erosion Program 
(Program 3) or non-eroded transect data entered in the Transect Data Entry 
and Editing Program (Program 2). 

• Select appropriate descriptions for each point under the Description of 
Surface column and the data points to include in RUNUP from the Station 
Status column.  Again, only 20 points may be used. 

• Select the Program menu from the RUNUP window and select Setup for 
RUNUP program. The Setup window will appear. 

The following fields will display the default information from the Transect Data 
Entry and Editing Program (Program 2): 

• Type of event – primary flooding source 

• Mean Wave Height – average wave height in feet. 

• Mean Wave Period – average time of wave height in seconds 

• Stillwater Elevation – in feet 
The Spread data field is for specifying the range of wave heights and periods for 
RUNUP to use and is default to 5%.  RUNUP will use the 5% higher input wave 
height, in combination with the 5% higher and lower wave periods.  Up to an 
additional 10% can be specified if the 5% range is not deemed significant. 
The Last Slope field is for entering the slope immediately landward of the last 
profile.  The field defaults to 50 and should be changed, if needed. 
The Job Number field identifies the RUNUP run and will be used in the titles of 
the input and output.  This field can be alphabetic or numeric. 

• Click the OK button. 
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Modeling 

RUNUP 
Running RUNUP (continued) 

• Click on the Graph button in the RUNUP Program window to plot the 
selected transect.  Additional data points can be inserted or removed, if 
needed. 

To add a transect point: 
• Click on the Insert button of the RUNUP Graph window. 

• Click on the point along the profile where additional points are needed. 

• Click on the Refresh button to update the graph to see the results of the new 
inserted points. 

• The station and elevation of the new points will not be inserted into the 
RUNUP data input table until the table is updated. 
o Select the Graph menu at the top of the RUNUP Information window. 
o Select Update Table from the menu. 

To delete a transect point: 
• Click on the points to be removed. 

• Click the Remove button. 
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Modeling 

RUNUP 
Running RUNUP (continued) 
If the points entered or removed are not correct, click on the Data button, then the 
Graph button before updating the table from the Graph menu. 

• Select the Program menu from the RUNUP window and select Run 
RUNUP to execute the program. 

• A CHAMP window will appear. 
o If the window displays, RUNUP run finished, the program is complete 

and ran successfully. Click the OK button. 
o If the window displays an error message, RUNUP did not run 

successfully and input data should be checked for errors. 
o While in the graph menu of the selected transect, select the Graph menu 

from the RUNUP window, then Graph Results to view the profile 
showing the input profile, stillwater elevations, and wave envelope. 

• The Average runup depth computed from the model results will be displayed 
in the Average Runup field in the upper right corner of the RUNUP 
Program window. 

The Results menu from the RUNUP window includes the input and output results. 

• Input text file 

• Output text file 

• Output Data Table 

• RUNUP Zone Table 

Exit the RUNUP program by clicking the [X] button in the upper right corner or 
select the File menu and select Exit. 
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Modeling 

Summary 
Upon completion of the Modeling section, you should now understand how to 
develop erosion, wave height, and wave runup models for transect data, and how to 
adjust these models, if necessary. 

You are now ready to view the results (graphical or tabular format) from the 
Modeling programs collectively in Summary Graphics and Tables (Program 6). 
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Summary Graphics and Tables 
The Summary Graphics and Tables Program is used to view all of the results from 
the analyses on selected transects. 

Tables 

• Click on the Tables button on the Main Menu Button bar. The Summary 
Table window for the selected transect will appear. 

• Each program phase of CHAMP is displayed with a check mark next to it, if 
completed.  This window is helpful in keeping track of the status of analyses 
if you should be need to work on them at a later time. 

To view input and output data and other analyses results in a table format, click on 
the Data Table drop down menu and select from the following data to view. 

• Transect 

• Adjusted Transect 

• Eroded Transect 

• WHAFIS 

• WHAFIS Parts 1 through 6 (individually) 

• Stillwater 

• WHAFIS Input File 

• WHAFIS Output File 

• RUNUP 

• RUNUP Output 

• RUNUP Input File 

• RUNUP Output File 

• RUNUP Zone 
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Summary Graphics and Tables 

Graphics 

• Click on the Graphics button on the Main Menu Button bar. The Summary 
Graphics window for the selected transect will appear. The graph displays 
all of the results from each program. 

• Each feature of the graph can be turned on or off under the Format menu of 
the Summary Graphics window and select Layers. 
o Select the feature to be turned on or off. 
o The feature is turned on if the Frozen column has a zero (0) beside that 

feature. 
o The feature is turned off if the Frozen column has a one (1) beside that 

feature. 
o Select Freeze to turn the feature off. 
o Select Thaw to turn the feature on. 
o Selecting the COLOR button on the Layers window and picking a color 

from the color menu can also change the colors of the features. 
o Selecting the L TYPE button on the Layers window and picking a line 

type from the line types menu can also change the line type of the 
features. 
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Summary Graphics and Tables 

Graphics (continued) 

• Selecting Print under the File menu of the Summary Graphics window can 
print the graphic. 

• These graphic files (.dxf) can be used with other CAD or GIS applications.  
They can also be saved as any of the following file types: 
o AutoCad Files (.dwg) 
o Windows Metafile (.wmf) 
o Bitmap (.bmp) 
o Enhanced Metafile (.emf) 

• To view the PFD Limits and Legend, click on Draw under the Summary 
Graphics window and select: 
o PFD Limits – a horizontal zone bar is drawn representing the minimum 

landward extent of the V-Zone. The PFD has to be identified in the Edit 
Transect module before the PFD limit can be drawn. 

o Legend – the legend is drawn on the right side of the graph. If features 
are turned on or off or colors are changed, the legend needs to be redrawn 
to match those features displayed. 
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Tutorial Summary 
Upon completion of the CHAMP Online Tutorial, you should have accomplished 
the following steps in assessing coastal flood hazards: 

• Input of profile data and flood-elevation information for one or a series of 
transects, each representing reaches of varying distances along the open 
coast and adjusted to create a (0,0) data point, if necessary; 

• Creation of an eroded beach profile for each transect to reflect post-storm 
conditions (primary frontal dune retreat or removal), if necessary; 

• Determination of the 1% annual chance (100-year) stillwater elevation for 
each transect, taking into account the effects of waves and/or wave run-up, 
as appropriate; 

• Compilation, in profile view, of the cumulative flood hazards for a base 
flood event for each transect, including water surface elevations, wave 
heights, wave run-up elevations, and flood hazards zones; and 

• Generation of summary graphics and tables describing the flood hazards 
modeled with this program. 
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Glossary Terms 
1% Annual Chance Stillwater Elevation (or 1% annual chance SWEL) 
The projected elevation of the flood having a 1% chance of being equaled or 
exceeded in any given year (100-year flood), in the absence of waves resulting 
from wind or seismic effects, referenced to the National Geodetic Vertical Datum, 
North American Vertical Datum, or other datum. 

10% Annual Chance Stillwater Elevation (or 10% annual chance SWEL) 
The projected elevation of the flood having a 10% chance of being equaled or 
exceeded in any given year (10-year flood), in the absence of waves resulting from 
wind or seismic effects, referenced to the National Geodetic Vertical Datum, North 
American Vertical Datum, or other datum. 

Above Surge (AS) 
This WHAFIS input card represents an area where the ground elevation 
temporarily rises above the 1% annual chance stillwater elevation, such as a high 
dune or other land mass. The stillwater elevation on the inland side may differ 
from that on the seaward side, though the station elevation on either side of the AS 
line segment must equal the applicable stillwater elevation on that side.  

Approach Slope 
The 1 on 40 sloping portion of the retreated dune profile, which lies immediately 
seaward of the 1 on 1 sloping dune face.  

Base Flood 
The flood having a 1-percent chance of being equaled or exceeded in any given 
year; also known as the 100-year flood.  The base flood, which is the standard used 
by most Federal and state agencies, is used by the National Flood Insurance 
Program (NFIP) as the standard for floodplain management and to determine the 
need for flood insurance. A structure located within a special flood hazard area 
shown on an NFIP map has a 26 percent chance of suffering flood damage during 
the term of a 30-year mortgage. 

Bathymetric Map 
A map depicting elevations of the earth’s surface at or below 0.0 NGVD (or other 
datum), that is, below the overlying water column. 

Buildings (BU) 
This WHAFIS input card represents an area where buildings (or groups of 
buildings) dissipate wave energy.  
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CAD 
A computer-based system for the design, drafting, and display of graphically 
oriented information. 

Coastal Hazard Analysis Modeling Program (CHAMP) 
CHAMP is a Windows-interfaced Visual Basic program that allows the user to 
enter data, perform coastal engineering analyses, view and tabulate results, and 
chart summary information for each representative transect along a coastline 
within a user-friendly graphical interface. 

Cross Section 
A line developed from topographic information, across a floodplain at which a 
computation of flood flow has been made to establish a potential flood elevation.  
Cross sections are shown on the Flood Boundary Floodway Map, Flood Insurance 
Rate Map, and/or Flood Profiles of a Flood Insurance Study. 

Datum 
FEMA's Flood Insurance Rate Maps (FIRMs) reference the elevation datum used 
to compute flood elevations. In completing elevation certificates, the same 
elevation datum as that shown on the FIRM must be used to compute lot and/or 
structure elevations and to compute flood elevations that are not given on the 
FIRM. The National Geodetic Vertical Datum (NGVD) is the national standard 
reference datum for elevations, formerly referred to as Mean Sea Level (MSL) of 
1929. NGVD is used as the reference datum on most FIRMs. 

Deposit Area 
The area of the upper shoreface that receives the sand eroded from the retreated 
frontal dune or bluff, characterized by a landward 1 on 40 slope and a seaward 1 on 
12.5 slope.  

Digital Terrain Model 
A computer representation of the altitude of the earth’s surface, which consists of 
spot elevations at regularly space intervals in the horizontal direction in the form of 
a grid.  

Dune 
Under the National Flood Insurance Program, natural or artificial ridges or 
mounds of sand located landward of the beach. 
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Dune (DU) 
This WHAFIS input card represents an area where wave energy is dissipated 
across a flooded sand dune or other natural or manmade, elongated barrier (e.g., 
levee, seawall).  

Dune Reservoir 
The cross sectional area of the frontal dune that lies above the 1% annual chance 
stillwater elevation and seaward of the dune peak (in a ridge-type dune) or rear 
shoulder (in a mound-type dune).  

Elevation 
Height of the land surface relative to NGVD or other vertical datum. 

End Transect (ET) 
This WHAFIS card is used to identify the last station in the transect, and is 
required.  

Erosion 
Under the National Flood Insurance Program, the process of the gradual wearing 
away of land masses.  In general, erosion involves detachment and movement of 
soil and rock fragments, either over the course of hours or days during a flood or 
storm, or over a period of years through the action of wind, water, or other 
geologic processes.   

Erosion Assessment 
To account for storm-induced erosion, an Erosion Assessment was established as 
part of the standard FEMA coastal methodology in 1989. According to Section 
65.11 of the National Flood Insurance Program regulations, if the cross-sectional 
area lying above the 1% annual chance stillwater elevation and seaward of the peak 
of the Primary Frontal Dune is less than 540 square feet, the dune is considered 
completely eroded during a base flood event.  If the area is greater than or equal to 
540 square feet, the dune retreats.  Each resulting condition has an associated post-
storm geometry, which is described in detail in the modeling section of this 
tutorial.  

Face Slope 
The eroded face of the retreating frontal dune or bluff, characterized by 1 on 1 
slope extending seaward from the dune peak. The 540 square feet of eroded 
material is taken from above the 1% annual chance stillwater elevation and 
seaward of this slope.   
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Federal Emergency Management Agency (FEMA) 
An independent agency of the Federal government, founded in 1979, which reports 
directly to the President.  FEMA is responsible for identifying and mitigating 
natural and man-made hazards.  The agency's mission is: 

to reduce loss of life and property and protect our nation's critical infrastructure 
from all types of hazards through a comprehensive, risk-based, emergency 
management program of mitigation, preparedness, response and recovery. 

Fetch 
The distance over which wind acts on the water surface to generate waves. 

Flood (also Flooding) 
A general and temporary condition of partial or complete inundation of normally 
dry land areas.  For flood insurance claim purposes, two or more structures must be 
inundated before flood damage will be covered. 

Flood Insurance Rate Map (FIRM) 
A map on which the 100-year (1% annual chance) and 500-year (0.2% annual 
chance) floodplains, Base Flood Elevations, and risk premium zones (and 
floodway information on Map Initiatives FIRMs) are delineated to enable 
insurance agents to issue accurate flood insurance policies to homeowners in 
communities participating in the National Flood Insurance Program. 

Flood Insurance Study (FIS) 
An examination, evaluation, and determination of flood hazards and, if appropriate 
corresponding water-surface elevations.  The resulting reports are used to develop 
Flood Insurance Rate Maps.  Also know as a flood elevation study. 

Flood Map Production Coordination Contractors (FMPCCs) 
Coordinates projects and provides technical support to FEMA. Duties of the 
FMPCC include · Researching available data for scoping activities · Completing 
base map research and providing independent quality assurance and control of 
study contractor and Cooperating Technical Community products · FIRM 
production · Preliminary and post-preliminary processing · Evaluation of National 
Flood Insurance Program Regulations, Part 65 revision and Part 70 amendment 
requests. 

Geographic Information System (GIS) 
A Geographic Information System (GIS) is a computer-based system used to 
capture, store, analyze and display geographic information. 
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Hurricane 
A tropical cyclone formed in the atmosphere over warm ocean areas, in which 
wind speeds equal or exceed 74 miles per hour and blow in a large spiral around a 
relatively calm center or “eye.”  Hurricane circulation is counter-clockwise in the 
Northern Hemisphere and clockwise in the Southern Hemisphere.  

Initial Elevation (IE) 
This WHAFIS input card describes the initial overwater fetch, wave conditions, 
and stillwater elevation for the first segment of the transect, starting at elevation 
0.0 NGVD (or other datum).  This line segment is required.   

Inland Fetch (IF) 
This WHAFIS input card represents an area where waves are regenerated across 
somewhat sheltered fetches and over shallow inland water bodies, using a 
sustained wind speed of 60 miles per hour.   

Interpolated 
A value calculated from values at neighboring stations.  

Marsh Grass (MG) 
When a VH card is used in WHAFIS to represent an area characterized by marsh 
grasses, additional data concerning the size and density of each vegetation type 
must be provided through the MG option in the VH dialog box. 

National Flood Insurance Program (NFIP) 
Federal insurance program under which flood-prone areas are identified and flood 
insurance is made available to residents of participating communities that agree to 
adopt and enforce floodplain management ordinances to reduce future flood 
damage. 

Northeaster 
An extra-tropical cyclonic weather system characterized by long duration, long 
fetch, and large area of circulation, occurring in late fall to early spring.  

Overwater Fetch (OF) 
This WHAFIS input card represents an area characterized by an unobstructed fetch 
over large bodies of water (water depth greater than 10 feet), where wave energy is 
regenerated using a sustained wind speed of 80 miles per hour. 

Peak (Dune peak)  
In ridge-type dunes, the seawardmost topographic high reached before the land 
surface slopes back down toward the dune heel; the dune peak used for the Erosion 
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Assessment is this seaward peak, which may not necessarily be the absolute 
highest elevation reached in any landward area of the dune or dune field.  In 
mound-type dunes, where there is relatively little elevation change between two or 
more undulations in the dune surface, the dune peak is considered the rear 
shoulder, or landwardmost high point before the land surface drops off rapidly to 
the dune heel.   

Primary Frontal Dune 
Under the National Flood Insurance Program, a continuous or nearly continuous 
mound or ridge of sand with relatively steep seaward and landward slopes 
immediately landward and adjacent to the beach and subject to erosion and 
overtopping from high tides and waves during major coastal storms.  The inland 
limit of the primary frontal dune occurs at the point where there is a distinct change 
from a relatively steep slope to a relatively mild slope.   

Reservoir Area 
In cross-section, the volume of sediment contained in the dune or bluff above the 
1% annual chance stillwater elevation and seaward of the dune crest (first peak) or 
rear shoulder.  

 
RUNUP 
RUNUP, Version 2.0, is a program for wave runup computation.  This program 
uses stillwater elevation, shore profile and roughness, and incident wave condition 
input information to compute a wave runup elevation that is consistent with the 
most detailed guidance currently available. 

Seaward Slope 
The seawardmost segment of the retreated dune profile, characterized by a 1 on 
12.5 slope, representing the terminus of deposition for the sand eroded from the 
dune face during the Erosion Assessment.  

Station 
A position where the horizontal distance from a user-established baseline is 
known.   

Storm induced erosion 
A synonym for flood-related erosion, which is defined in the NFIP regulations as 
the collapse or subsidence of land along the shore of a lake or other body of water 
as a result of undermining caused by waves or currents exceeding anticipated 
cyclical levels. While this definition includes sudden erosion caused by elevated 
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water levels associated with severe storms, it does not apply to gradual erosion 
occurring over years to decades.  CHAMP does not account for the effects of long-
term erosion. 

Storm surge  
The rise in the water surface above normal water level on the open coast due to the 
action of wind stress and atmospheric pressure.  

Toe (Dune toe) 
The junction of the gentle slope seaward of the main body of the dune and the dune 
face, which is marked by a slope of 1 on 10 or steeper.  

Topographic Map 
A map depicting elevations of the earth’s surface at or above 0.0 NGVD (or other 
datum).  

Transect 
A series of two or more stations for which the horizontal position and absolute 
elevation are known, aligned perpendicular to the predominant orientation of the 
shoreline.  A transect is selected such that it is representative (in terms of 
topographic, vegetative, and cultural characteristics) of a defined area (or reach) on 
either side.   

Tsunami 
A long-period water wave generated by undersea, shallow-focus earthquakes or by 
undersea crustal displacements, landslides, or volcanic activity.  Tsunamis can 
travel great distances, undetected in deep water but shoaling rapidly in coastal 
waters and producing a series of large, destructive waves.  

US Army Corp of Engineers 
Founded in 1802, the United States Army Corps of Engineers (USACE) is made 
up of approximately 34,600 civilian and 650 military men and women. The corps’ 
military and civilian engineers, scientists and other specialists work hand in hand 
as leaders in engineering and environmental matters. 

Vegetation (VE) 
This WHAFIS input card represents an area where wave energy is dissipated due 
to rigid vegetation, which can be modeled as an equivalent “stand” of equally 
spaced circular cylinders (e.g., trees, shrubs).  
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Vegetation Header (VH) 
This WHAFIS input card represents an area where wave energy is dissipated due 
to marsh vegetation that is flexible and oscillates with wave action.  This card must 
precede any “MG” (Marsh Grass) line segment, if applicable.  

Water-Surface Elevation 
The height, in relation to the National Geodetic Vertical Datum of 1929 (or other 
datum, where specified) of floods of various magnitudes and frequencies in the 
identified floodplains of coastal or riverine areas. 

Wave Crest 
The highest point on a ridge, deformation, or undulation of the water surface. 

Wave Height Analysis for Flood Insurance Studies (WHAFIS) 
Wave Height Analysis for Flood Insurance Studies (WHAFIS), Version 3.0, is a 
DOS-based program that uses representative transects to compute wave crest 
elevations in a given study area. Transects are selected considering major 
topographic, vegetative, and cultural features. WHAFIS uses this and other input 
information to compute an appropriate depth-limited wave height at the seaward 
end of each transect. 

Wave Setup 
The elevation, or apparent rise, of the water surface over normal storm surge 
elevation due to the onshore mass transport of the water mass transport of the 
water action alone. 

ZONE AE  
The flood insurance rate zone that corresponds to the 100-year floodplains that is 
determined in the Flood Insurance Study by detailed methods. In most instances, 
Base Flood Elevations derived from the detailed hydraulic analyses are shown at 
selected intervals within this zone. Mandatory flood insurance purchase 
requirements apply. 

ZONE VE 
The flood insurance rate zone that corresponds to the 100-year coastal floodplains 
that have additional hazards associated with storm waves.  Base Flood Elevations 
derived from the detailed hydraulic analyses are shown at selected intervals within 
this zone. Mandatory flood insurance purchase requirements apply. 
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